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摘要

UCD3138x 器件是专为电源应用而设计的数字电源控制器。本应用手册是回答以下问题的重要参考资料：

1. 什么是 UCD3138x 器件？
2. 为什么使用 UCD3138x 器件？
3. TI 为 UCD3138x 器件提供哪些资源？
4. 如何了解有关 UCD3138x 器件的更多信息？

本指南涵盖了使用 UCD3138x 器件进行开发的所有方面，包括硬件、软件、应用和其他支持。除了主要的参考文

档外，每个部分还提供了相关链接和资源，可帮助用户进一步了解相关信息。
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1 快速入门

1. 前往 ti.com/digitalpower 以了解 UCD3138x 产品选择。

2. 观看数字电源控制器简介视频系列的基础知识和工具 部分的教程。

3. 下载并安装 Code Composer Studio™ + Fusion Digital Power Studio™。

a. 为 Arm® 编译器 v5.2.4 配置 CCS。
4. 购买 UCD3138x 硬件。

a. 要关注 UCD 培训实验室，请购买开环评估模块 (EVM) 和 USB 转 GPIO2 适配器。

b. 接下来，根据您的拓扑（PFC、LLC、HSFB、PSFB）购买闭环应用 EVM
i. 应用 EVM 附带已组装的 PCB、预编程的 UCD3138x 数字控制器、控制卡和适配器。

c. 或者，构建参考设计并同时购买 UCD3138x 控制器和适配器。

5. 观看其余视频教程并开始开发！
a. 利用 TI E2E™ 设计支持论坛、UCD31xx 技术参考手册和 UCD3138 FW_SDK。
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2 生态系统

UCD3138x 器件的生态系统包含众多硬件、开发工具和软件，可支持各类应用。更多有关此生态系统各个部分的

信息，请参阅本文档中的相应部分。
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图 2-1. UCD3138x 生态系统图

备注
UCD3138x 器件可用于各种应用，包括所示的终端设备。
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3 简介

UCD3138x 系列数字电源控制器在一个单芯片解决方案内提供高集成度和优异的性能。UCD3138x 器件非常灵

活，专为各种电源转换应用而设计。此外，器件内的多重外设已进行了专门优化以提升交流/直流和直流/直流应用

性能并减少元件总数。

UCD3138x 器件是完全可编程的电源控制器，可以为客户提供完整的设计控制和自主操作。由于采用高级别的配

置，无需复杂的固件。TI 通过易于使用的集成工具简化了我们客户的开发过程。UCD3138x 器件可以使用 TI 的 

Code Composer Studio™ (CCS) 集成开发环境 (IDE) 或我们强大的 Fusion Digital Power Studio 图形用户界面 

(GUI) 套件进行编程。因此，客户可以获得数字控制的强大功能和灵活性，而无需面对复杂固件的挑战。

UCD3138x 器件的核心是数字控制环路外设，也称作数字电源外设 (DPP)。这些 DPP 是独立于内部微控制器 

(MCU) 的高速数字控制环路。每个 DPP 由一个误差模数转换器 (EADC)、一个基于 PID 的补偿器和 DPWM 输出

组成。UCD3138x 器件还具有用于实时检测的通用 ADC。最后，UCD3138x 器件可以通过通用异步接收器/发送

器 (UART)、内部集成电路 (I2C) 或电源管理总线 (PMBus) 与外部外设通信。所有进程均由内部 32 位 Arm®7 
MCU 通过可编程闪存存储器或片上 RAM/ROM 进行管理。

Arm®-based Housekeeping 

Processor and Peripherals

PFC Controller LLC Controller PSFB Controller

Buck Controller Boost Controller Buck-Boost Controller

Dedicated Hardware-based Power Stage Controllers

The UCD3138x Devices enhance your design by combining a Dedicated Hardware-based Power 

Stage Controller with an Arm-based Housekeeping Processor and Peripherals  

图 3-1. UCD3138x 器件的抽象
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4 TI 电源控制器选项

本节讨论了使用 UCD3138x 器件的动机以及 ti.com 上提供的不同封装。

4.1 电源控制器格局

常见的电源转换器通常使用模拟控制器，例如 TI UCCx 产品，因为模拟控制器简单且成本低。在更高功率和复杂

功率转换器中，需要更灵活的产品。工程师关注的典型选项是基于 DSP 的微控制器，例如 TI C2x 产品。但是，
基于 DSP 的微控制器具有较高的固件技能和元件成本，这令工程师望而却步。基于 DSP 的控制器的响应速度也

较慢，并且受到 MCU 带宽的限制。因此，工程师可能需要一个比模拟具有更多功能的电源控制器，但该控制器并

非严格由软件驱动。

UCD3138x 器件力求通过结合模拟微控制器和基于 DSP 的微控制器的优势来弥补这一差距。UCD3138x 器件是

完全可编程的，可实现灵活的设计。此外，TI 的 Fusion Digital Power Studio GUI 套件让我们的客户无需大量编

程即可轻松定制设计。UCD3138x 器件也是专门针对电源转换器而设计的。专用电源环路不受 MCU 带宽的限

制，固件设计为可轻松针对电源应用进行配置。因此，电源工程师可以设计快速而灵活的电源转换器。

Analog Controller
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 - Faster Response

UCD3138x devices fill the gap in the power 

controller landscape by combining the benefits of 

an analog controller and a DSP-based 

microcontroller. The UCD3138x devices have 

flexibility and fast response, and require low 

firmware skill.
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Power Controller Landscape

图 4-1. 电源控制器格局

4.2 UCD3138x 产品选择

UCD3138x 系列有多种器件可供选择。主要区别是闪存存储器大小和引脚数。UCD3138xA 器件还通过启用同步

整流 (SR) 功能来提供增强型参数，例如死区时间控制 (DTC)。表 4-1 展示了每个可用 UCD3138x 器件的闪存存

储器和引脚数。
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表 4-1. ti.com 上提供 UCD3138x 器件和封装
UCD3138x 器件比较

产品 40 引脚 QFN 64 引脚 QFN 80 引脚 QFP

UCD3138128A（带增强型参数的 

128kB 闪存）

不适用

不适用UCD3138128（128kB 闪存）

UCD3138A64（64kB 闪存）

UCD3138064A（带增强型参数的 

64kB 闪存）

不适用

UCD3138064（64kB 闪存）

UCD3138A（带增强型参数的 32kB 
闪存）

UCD3138（32kB 闪存）
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5 TI 硬件

本节展示了 TI 的整个 UCD3138x 硬件产品系列，可协助您借助 UCD3138x 器件快速开始开发。

5.1 开环 EVM
UCD3138x 开环评估模块 (EVM) 提供了一个易于使用的测试平台，用于对 UCD3138x 数字控制器进行独立评

估。这些 EVM 供硬件和固件工程师操控各个引脚上的信号以及研究开环运行。还有许多端口和外设用于测试单个

信号和通信，例如 UART、I2C 和 PMBus。TI 提供包含开环 EVM 的培训实验室，以了解 UCD3138x 器件。

TI 为每个 UCD3138x 器件引脚分配选项提供了三个开环 EVM。

表 5-1. TI.com 上提供了 UCD3138x 器件开环 (OL) 硬件。

UCD3138x 开环 (OL) EVM

40 引脚 QFN 64 引脚 QFN 80 引脚 QFP

UCD3138OL40EVM-032 UCD3138OL64EVM-031 UCD3138A64OEVM-662

5.2 应用 EVM
UCD3138x 应用 EVM 展示了各种电源转换器中的 UCD3138x 器件。TI.com 上提供了四个应用 EVM，其中三个

需要附带 UCD3138x 控制卡 (CC)。

表 5-2. TI.com 上提供 UCD3138x 应用硬件

UCD3138x 应用套件

评估模块 (EVM) 说明 特殊特性 控制卡？

• 单相 PFC、双相交错 PFC 
或无桥 PFC

• 360W、400VDC 额定功率

• 通用交流输入：95VAC 至 

265VAC

• 高 PF 和低 iTHD（负载为 20% 时小于 

5%，负载为 100% 时小于 2%）
• 可实现小于 1 的精度和功耗计量精度

Y

UCD3138x PFC EVM：UCD3138PFCEVM-026

• 硬开关式全桥直流/直流

• 恒定电流和恒定功率

• 次级侧控制

• 360W 满载功率

• 满负载电流为 30A
• 直流输入：36VDC 至 

72VDC

• 支持具有恒定启动时间的输入电压前馈

控制

• 支持电压模式控制

• 支持峰值电流模式控制

N

UCD3138x HSFB EVM：UCD3138HSFBEVM-029

• 高效、数字控制和独立相移

全桥直流/直流电源转换

• 360W 满载功率

• 满负载电流为 30A
• 直流输入：350VDC 至 

400VDC

• 恒定电流和恒定功率

• 次级侧控制

• 恒定启动时间

Y

TI 硬件 www.ti.com.cn

8 UCD3138x 器件简介 ZHCADK6 – DECEMBER 2023
提交文档反馈

English Document: SLUAAS7
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/tool/UCD3138OL40EVM-032
https://www.ti.com/tool/UCD3138OL64EVM-031
https://www.ti.com/tool/UCD3138A64OEVM-662
https://www.ti.com/tool/UCD3138PFCEVM-026
https://www.ti.com/tool/UCD3138HSFBEVM-029
https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCADK6
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCADK6&partnum=
https://www.ti.com/lit/pdf/SLUAAS7


表 5-2. TI.com 上提供 UCD3138x 应用硬件 （续）
UCD3138x 应用套件

评估模块 (EVM) 说明 特殊特性 控制卡？
UCD3138x PSFB EVM：UCD3138PSFBEVM-027

• 用于直流/直流电源转换的

谐振半桥 LLC
• 支持同步整流

• 340W 满载功率

• 满负载电流为 29A
• 直流输入：350VDC 至 

400VDC

• 具有占空比匹配保护的突发模式逐周期

电流限制

• 过压、过流和欠压功能

Y

UCD3138x LLC EVM：UCD3138ALLCEVM150

A. 一些 EVM 需要控制卡 (CC)。

5.3 控制卡

UCD3138x 控制卡 (CC) 是用于与外部电源转换器一起运行或独立研究的子卡。通过将 UCD3138x 器件放置在单

独的 PCB 上，可以将数字控制器抽象出来，这样就可以单独评估电源转换器。控制卡还包含用于外部通信和调试

的 PMBus 和 JTAG 接头。每个控制卡支持不同的 UCD3138x 器件。

表 5-3. TI.com 上提供了 UCD3138x 器件控制卡 (CC) 硬件

UCD3138x 控制卡 (CC) EVM

64 引脚 QFN 80 引脚 QFP

UCD3138CC64EVM-030
64 引脚 CC EVM

包括：UCD3138（32kB 闪存）

UCD3138064EVM-166
64 引脚 CC EVM

包括：UCD3138064（64kB 闪存）

UCD3138A64CEVM-660
80 引脚 CC EVM

包括：UCD3138A64（64kB 闪存）
支持：UCD3138128（128kB 闪存）

UCD3138128A（带增强型参数的 128kB 闪
存）

UCD3138ACCEVM149
64 引脚 CC EVM

包括：UCD3138A（带增强型参数的 32kB 闪
存）

UCD3138064AEVM149
64 引脚 CC EVM

包括：UCD3138064A（带增强型参数的 

64kB 闪存）

UCD3138PFCEVM-026 功率因数校正 EVM 展示了 UCD3138x 器件控制卡如何插入到电源转换器 PCB 中。电源

转换器 PCB 有一个可连接控制卡的 I/O 接头。控制卡电源通常由电源转换器 PCB 提供。

www.ti.com.cn TI 硬件
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图 5-1. UCD3138PFCEVM-026

5.4 参考设计

TI 参考设计库是一个涵盖模拟、嵌入式处理器和连接等内容的强大参考设计资源库。所有参考设计均由 TI 专家构

建，旨在帮助您着手进行系统设计，其中包括原理图或方框图、BOM 和设计文件，助您加快产品上市步伐。

搜索并下载 UCD3138 参考设计。

6 编程器和调试器

TI 和第三方提供了多种用于编程和调试 UCD3138x 器件的硬件和软件工具。本节重点介绍两个主要的硬件工具。

但是，其他工具也是兼容的。

6.1 USB 转 GPIO2 接口适配器

USB 转 GPIO2 接口适配器是 UCD3138x 器件与主机 PC 之间的主要通信桥接器。该适配器通过 PMBus 与 

UCD3138x 进行通信，并通过 USB 与主机 PC 进行通信。

产品页面：USB 转 GPIO2

6.2 JTAG 调试器

可通过 JTAG 对 UCD3138x 器件进行编程和调试。推荐使用 XDS110 JTAG 调试探针将 CCS 软件编程到 

UCD3138x 器件上。

产品页面：TMDSEMU110-U。
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7 软件

TI 为 UCD3138x 器件提供全面的培训和软件库，以支持客户的开发。

7.1 UCD3138x 培训实验室

TI 提供 UCD3138x 培训实验室来快速开始软件开发。培训实验室包括一个由 5 部分组成的视频系列，并随附培训

实验室固件。

要开始使用 UCD3138x 培训实验室：

1. 购买 UCD3138x 开环 EVM（40 引脚、64 引脚或 80 引脚）。

2. 购买 USB 转 GPIO2 接口适配器。

3. 下载 Code Composer Studio (CCS) 和 Fusion Digital Power Studio。
4. 为 Arm v5.2.4 配置 CCS。
5. 下载 UCD-TRAINING-LABS；
6. 观看数字电源控制器简介视频系列。

UCD3138x 培训实验分为以下几个部分：

• UCD3138x 一般介绍和概述

• 实验 1：UCD3138x 基础知识和工具

• 实验 2：数字 PWM (DPWM) 模块

• 实验 3：数字滤波器 (EADC) 模块

• 实验 4：模拟前端

• 实验 5：JTAG 接口

下载：

单机版本：UCD-TRAINING-LABS

7.2 UCD3138 应用开发固件套件 Kit
UCD3138 应用开发固件套件是一款适用于 6 种不同电源拓扑的免费软件开发套件 (SDK)：

• 功率因数校正 (PFC)
• 谐振半桥 LLC
• 相移全桥 LLC (PS-LLC)
• 硬开关全桥 (HSFB)
• 相移全桥 (PSFB)
• 非隔离式双向转换器

该开发套件可在评估和开发阶段提供帮助。该开发套件包含固件开发工具以及每种拓扑的配套资料。未来将有更
多拓扑可用。

下载

单机版本：UCD3138_FW_SDK

7.3 自定义固件

经验丰富的用户可以开发包括多功率级控制、电子计量、诊断、自动关断等功能的自定义固件！有关详细技术信

息，请参见 UCD31xx 技术参考手册。
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8 开发工具

TI 提供了大量开发工具来支持客户的设计。

Develop Firmware with Code 

Composer Studio (CCS)

Debug Production Firmware with 

JTAG using UniFlash

Configure and Flash Firmware 

using Fusion Digital Power 

Studio

图 8-1. UCD3138x 固件开发流程

8.1 Code Composer Studio (CCS)
Code Composer Studio 是一种集成开发环境 (IDE)，支持 TI 的微控制器和嵌入式处理器产品系列。Code 
Composer Studio 包含一整套用于开发和调试嵌入式产品的简单工具。Code Composer Studio 包含用于优化的 

C/C++ 编译器、源代码编辑器、工程构建环境、调试器、性能分析器以及很多其他功能。该 IDE 提供单一界面，
可帮助用户完成应用开发流程的每个步骤。熟悉的工具和界面使用户能够比以前更快地入手。

在 Code Composer Studio 上进行 UCD3138x 器件的固件开发需要使用 Arm 编译器 v5.2.4。要设置 Arm 编译器 

v5.2.4，请完成以下步骤：

1. 安装并打开 Code Composer Studio 的最新版本。

2. 依次前往 Help → Install New Software…。

3. 点击 What is already installed? 并卸载任何高于 v5.2.4 的 Arm 编译器版本。删除所有其他 Arm 版本后，重

新启动 Code Composer Studio。
4. 依次前往 Help → Install New Software…。

5. 在下拉列表中选择 All Available Sites，然后选中 Arm Compiler Tools 版本 5.2.4。点击 Next，接受协议，
然后完成。然后，重新启动 Code Composer Studio。

6. 安装完 Arm 编译器 v5.2.4 后，依次前往 Project → Properties → General → Compiler version 更改编译

器版本，然后在下拉菜单中选择 TI v5.2.4。
7. 构建 UCD 工程。

有关更多详细信息，请参阅有关 Code Composer Studio 设置的 E2E 常见问题解答。

下载

• 单机版本：CCSTUDIO
• 在线版本：CCS Cloud

资源

Code Composer Studio 用户指南介绍了 Code Composer Studio IDE 的特性和功能。
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8.2 Fusion Digital Power Studio
Fusion Digital Power Studio 包含适用于德州仪器 (TI) 的 UCD3138x 集成数字控制器系列的软件工具。该软件使

用图形用户界面 (GUI)，可帮助电源工程师无需学习复杂的编程技能即可从数字电源获益。GUI 是直观的工具，可

在设计的评估、开发和测试阶段提供帮助。

Fusion Digital Power Studio 包含各种工具，这些工具专为在评估、设计和生产阶段为工程师提供帮助而设计。

Fusion Digital Power Studio GUI (1)
Fusion Digital Power Studio GUI (2)

下载

• 单机版本：FUSION-DIGITAL-POWER-STUDIO

参考资料

适用于隔离电源应用的 Fusion Digital Power Studio GUI 是该软件的深入用户指南。

8.3 UniFlash
UniFlash 是 TI 开发的一个编程 GUI 工具，支持 JTAG。客户可对 UCD3138x 器件的片上闪存进行调试和编程。

UniFlash 提供图形界面和命令行界面。

下载

• 单机版本：UNIFLASH
• 在线版本：UniFlash Cloud

资源

UniFlash 快速入门指南介绍了 UniFlash 的特性和功能。
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9 应用

本节讨论了如何在各种电源转换器中使用 UCD3138x 器件，以及这些器件如何改进您的设计。

UCD3138x 器件在各种应用中性能优异。下面突出显示了五个主要类别：

• 多串联功率级
• 多并联功率级
• 高性能
• 外部通信
• 功率密度高

UCD3138x 器件采用基于硬件的专用功率级控制器，可实现高性能和高灵活性。这是一个可配置的控制环路，蚀

刻在器件上，与 MCU 无关。因此，控制环路易于配置且不受 MCU 带宽限制。

4x Fully programmable 

DPWM modules

Fully programmable PID controller 

(2 pole/2 zero)

3x Fully programmable high-

speed Error Analog-to-Digital 

Converters (EADC)

Digital 

Components

General Purpose 

Input/outputs 

(GPIO)
Memory: 

Includes 

RAM+ECC, 

Flash, ROM and 

Security

31.25MHz 32-bit Arm7 

Microcontroller

(90% MIPS available for 

housekeeping)
External Connection: Includes 

UART, I2C and PMBus

General Purpose 

ADCs

Timers and Interrupt Service 

Routines (ISR)  

Analog 

Components

DPWM0

DPWM1

DPWM2

DPWM3
EAP2

EAP1

EAP0

Dedicated Hardware-based Power Stage Controller

Arm®-based Housekeeping Processor and Peripherals

图 9-1. UCD3138x 器件的功能方框图

9.1 多串联功率级

典型的电源应用需要多个串联的功率级来满足系统要求。例如，离线交流/直流电路通常包含单相升压 PFC，后跟

谐振 LLC 转换器和同步降压转换器。这三种拓扑中的每一种都需要单独的模拟控制器。还可以通过添加同步整流 

(SR) 来提高性能。下图显示了一个简化的应用，不包含栅极驱动器等其他器件。

GND-P

Boost PFC 

Controller

GND-S

HB-LLC 

Controller

Synchronous 

Buck 

Controller

= Analog Controller

= PWM

= Feedback

SR 

Controller

Boost PFC

Half-Bridge Resonant LLC
Synchronous Buck

Synchronous 

Rectification

图 9-2. 具有 SR 的典型 3 级电源转换器系统需要四个独立的模拟控制器
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另一方面，UCD3138x 器件可以控制多个串联的功率级。UCD3138x 器件可使用三个 EADC 控制多达三个不同的

控制环路。每个 UCD3138x 器件还可以输出多达 8 个唯一的 DPWM。每个功率级均可独立配置或组合配置，从

而打造高效的低元件数系统。

GND-P

GND-S

= Analog Device

= PWM

= Feedback

= Digital Controller

UCD3138xA

DPWM0

DPWM1

EAP0

EAP1
DPWM2 EAP2DPWM3

Isolated Gate 

Driver

Optocoupler

Isolated Gate 

Driver

Optocoupler

(2x) 

UCD7138

Boost PFC

Half-Bridge Resonant LLC

Synchronous Buck

Synchronous 

Rectification

图 9-3. UCD3138x 器件可以控制多个串联级

A. UCD3138xA 器件具有增强型参数，例如 SR 控制。

主要参考设计：

• PMP40586：1kW 数字控制电流模式 LLC 参考设计

9.2 多并联功率级

其他电源转换应用需要并联多个电源转换器。一个系统可能需要来自单个源的多个输出。例如，对于双向电池充

电应用，48V 电动汽车电池可能需要多个并联的同步降压转换器。典型的设计要求每个功率级具有单独的模拟控

制器。
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GND

Synchronous 

Buck 

Controller

GND

Synchronous 

Buck 

Controller

GND

Synchronous 

Buck 

Controller

GND

Synchronous 

Buck 

Controller

+48V

+12V

+12V

+12V

+12V

= Analog Controller

= PWM

图 9-4. 使用模拟控制器的并联功率级

UCD3138x 器件通过同时控制所有功率级来提高效率和功率密度。通过利用 8 个 DPWM 输出，可对多个功率级

进行串联控制。因此，只需一个控制器即可提供系统级设计。

+48V

GND

DPWMA

DPWMB

GND

DPWMA

DPWMB

GND

DPWMA

DPWMB

GND

DPWMA

DPWMB

UCD3138x
DPWM0 DPWM1 DPWM2 DPWM3 = Digital Controller

= PWM

+12V

+12V

+12V

+12V

图 9-5. 使用 UCD3138x 器件的并联功率级

TIDA-00653 参考设计提供了由一个 UCD3138x 器件控制的多个并联功率级的示例。
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图 9-6. TIDA-00653 使用一个 UCD3138128 来演示多个输出

主要参考设计

• TIDA-00653：用于电池充电应用的非隔离式双向转换器参考设计

• PMP4333：用于电信的 1kW 三轨隔离式直流/直流数字电源

9.3 高性能和外部通信

无法通过模拟控制器轻松实现图腾柱 PFC 等高效的高功率拓扑。典型的模拟控制器也没有外部通信特性，因此与

系统隔绝。

UCD3138x 器件可通过高效的高功率拓扑和外部通信来升级电源转换器。UCD3138x 器件可控制模拟控制器无法

控制的多种复杂拓扑。

控制独立功率级的 UCD3138x 器件也可以相互通信，以进一步优化系统性能。所有 UCD3138x 器件都具有 

UART、I2C 和 PMBus 外设。外部通信具有特殊功能，例如电子计量、诊断、自动关断等！
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GND-P

GND-S

UCD3138x
UCD3138xA

DPWM1

EAP0

DPWM2

DPWM0

UART
I2C or PMBus

(2x) 

UCD7138

Isolated Gate 

Driver

Optocoupler

Isolated Gate 

Driver

Isolated 

UART

DPWM0 DPWM1 EAP0

UART

External Communication

= Analog Device

= PWM

= Feedback

= Digital Controller

= Serial Communication

Totem-Pole PFC

Phase-Shifted Full-Bridge

Synchronous Rectification

UCD3138x Devices increase performance by enabling high-power solutions, such as Totem-pole PFC 

(additional features enabled by external communication, such as e-metering, can also be utilized  

图 9-7. 使用 UCD3138x 器件的典型高性能应用

主要参考设计

• PMP8877：1/8 砖型隔离式直流/直流电信电源模块数字控制参考设计

• PMP20873：效率高达 99% 且基于 GaN 的 1kW CCM 图腾柱功率因数校正 (PFC) 转换器参考设计
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9.4 功率密度高

UCD3138x 器件的控制器数量较少，并且与 GaN 和 SiC 等高功率技术集成，因而可提供高功率密度。因此，可

实现紧凑而强大的设计。PMP23340 参考设计展示了高功率密度、高功效和高输出功率 GaN 模块中的 

UCD3138x。PMP23340 的功率密度 >1250W/in^3

UCD3138A

图 9-8. PMP23340 使用 UCD3138A 展示高功率密度

主要参考设计

• PMP23340：1/8 砖型高功率密度 GaN 电源模块

• PMP4435：具有 GaN FET 的 48V 输入电压、300W 1/8 砖型数字模块参考设计

• PMP22220：1500W 交流开关无桥式 PFC 参考设计

10 支持资源

本节重点介绍了可协助进行 UCD3138x 器件开发的更多参考资料。

10.1 文档

UCD3138x 器件拥有丰富的文档，可提供一般概述、产品选择和特定于拓扑的设计方面的帮助。有关详细信息，
请参阅 节 12。

10.2 TI E2E 支持论坛

此论坛是工程师的重要参考资源，可直接从专家那里获得快速、经过验证的解答和设计帮助。搜索现有解答或自

行提出问题，以获得所需的快速设计帮助。E2E 使用入门页面按时间顺序列出了 TI E2E 论坛中特定任务的常见问

题解答。

链接的内容由各个贡献者“按原样”提供。该内容并不构成 TI 技术规范，并且不一定反映 TI 的观点；请参阅 TI 
的使用条款。
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11 总结

UCD3138x 器件将模拟控制器和基于 DSP 的微控制器的优势相结合，填补了电源控制器市场的空白。UCD3138x 
器件具有较高的灵活性和快速响应时间，并且固件技能要求较低。UCD3138x 器件在多种应用中性能优异，包括

多功率级、高性能和高功率密度。德州仪器 (TI) 提供了大量资源，包括强大的 GUI、硬件 EVM、软件开发套件和

应用手册，可帮助我们的客户快速学习和开始使用 UCD3138x 器件。
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12 参考资料

通用设计指南

• 德州仪器 (TI)，如何并行使用两个带数字控制器的直流/直流转换器 模拟设计期刊。

• 德州仪器 (TI)，带数控隔离式直流/直流的快速输入电压瞬态响应 模拟应用期刊。

• 德州仪器 (TI)，UCD3138 系列 – 实用设计指南 应用报告。

• 德州仪器 (TI)，UCD3138A 迁移指南 应用报告。

• 德州仪器 (TI)，UCD3138064A 迁移指南 应用报告。

• 德州仪器 (TI)，UCD3138128A 迁移指南 应用报告。

• 德州仪器 (TI)，设计数控电源 技术文章。

• 德州仪器 (TI)，PID 滤波器的 UCD3138 积分分支 应用报告。

• 德州仪器 (TI)，使用 UCD7138 和 UCD3138A 实现高级同步整流控制 应用报告。

• 德州仪器 (TI)，UCD3138128A 迁移指南 用户指南。

编程指南

• 德州仪器 (TI)，UCD31xx 技术参考手册
• 德州仪器 (TI)，UCD3138064 编程手册
• 德州仪器 (TI)，UCD3138 器件上的栈溢出检测 应用手册。

• 德州仪器 (TI)，避免 UCD3138 器件锁定 应用手册。

• 德州仪器 (TI)，UCD3138 中的自动波特率检测和配置 应用手册。

• 德州仪器 (TI)，适用于 UCD3138 隔离电源应用的 Fusion Digital Power Studio 用户指南。

• 德州仪器 (TI)，UCD3138 – 响应多个 PMBus 从器件地址 应用报告。

• 德州仪器 (TI)，设计数字电源：如何编写固件 技术文章。

• 德州仪器 (TI)，了解 UCD31xx 器件中的 CPU 锁定机制 应用报告。

PFC 资源

• 德州仪器 (TI)，设计数字电源：如何编写固件工具。

• 德州仪器 (TI)，UCD3138FW-PFC 工具。

• 德州仪器 (TI)，采用峰值电流模式控制的功率因数校正 模拟设计期刊。

• 德州仪器 (TI)，用于交错式升压 PFC 的数字电流平衡 模拟设计期刊。

• 德州仪器 (TI)，通过对 PFC EMI 电容器无功电流进行数字补偿来提高功率因数 模拟应用期刊。

• 德州仪器 (TI)，如何提高 PFC 轻载效率 模拟设计期刊。

• 德州仪器 (TI)，如何降低图腾柱 PFC 交流过零点处的电流尖峰 模拟应用期刊

• 德州仪器 (TI)，设计 UCD3138 受控单相 PFC 应用报告。

• 德州仪器 (TI)，设计 UCD3138 受控交错 PFC 应用报告。

• 德州仪器 (TI)，设计 UCD3138 受控无桥 PFC 应用报告。

• 德州仪器 (TI)，在交错 PFC 或无桥 PFC 配置中评估 UCD3138 应用手册。

• 德州仪器 (TI)，通过 ZVS 或谷底开关降低 PFC THD 和提升效率 应用报告。

• 德州仪器 (TI)，使用 UCD3138 降低交流中断测试期间 PFC 级中的电气应力 应用报告。

• 德州仪器 (TI)，采用 UCD3138 降低 DCM PFC 的 THD 应用报告。

• 德州仪器 (TI)，UCD3138 PFC 调优 应用报告。

LLC 资源

• 德州仪器 (TI)，UCD3138ALLCEVM150 工具。

• 德州仪器 (TI)，UCD3138FW-FBLLC 工具。

• 德州仪器 (TI)，UCD3138FW_LLC 工具。

• 德州仪器 (TI)，LLC 转换器小信号建模 工具。

HSFB 资源

• 德州仪器 (TI)，UCD3138HSFBEVM-029 工具。

• 德州仪器 (TI)，UCD3138FW-HSFB 工具。

• 德州仪器 (TI)，带数控隔离式直流/直流的快速输入电压瞬态响应 模拟应用期刊。
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PSFB 资源

• 德州仪器 (TI)，UCD3138PSFBEVM-027 工具。

• 德州仪器 (TI)，UCD3138FW-PSFB 工具。

双向资源

• 德州仪器 (TI)，UCD3138FW-BIDI 工具。

• 德州仪器 (TI)，四开关降压/升压转换器的多模式控制 模拟设计期刊。
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重要声明和免责声明
TI“按原样”提供技术和可靠性数据（包括数据表）、设计资源（包括参考设计）、应用或其他设计建议、网络工具、安全信息和其他资源，
不保证没有瑕疵且不做出任何明示或暗示的担保，包括但不限于对适销性、某特定用途方面的适用性或不侵犯任何第三方知识产权的暗示担
保。
这些资源可供使用 TI 产品进行设计的熟练开发人员使用。您将自行承担以下全部责任：(1) 针对您的应用选择合适的 TI 产品，(2) 设计、验
证并测试您的应用，(3) 确保您的应用满足相应标准以及任何其他功能安全、信息安全、监管或其他要求。
这些资源如有变更，恕不另行通知。TI 授权您仅可将这些资源用于研发本资源所述的 TI 产品的应用。严禁对这些资源进行其他复制或展示。
您无权使用任何其他 TI 知识产权或任何第三方知识产权。您应全额赔偿因在这些资源的使用中对 TI 及其代表造成的任何索赔、损害、成
本、损失和债务，TI 对此概不负责。
TI 提供的产品受 TI 的销售条款或 ti.com 上其他适用条款/TI 产品随附的其他适用条款的约束。TI 提供这些资源并不会扩展或以其他方式更改 
TI 针对 TI 产品发布的适用的担保或担保免责声明。
TI 反对并拒绝您可能提出的任何其他或不同的条款。IMPORTANT NOTICE

邮寄地址：Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2024，德州仪器 (TI) 公司

https://www.ti.com.cn/zh-cn/legal/terms-conditions/terms-of-sale.html
https://www.ti.com

	内容
	商标
	1 快速入门
	2 生态系统
	3 简介
	4 TI 电源控制器选项
	4.1 电源控制器格局
	4.2 UCD3138x 产品选择

	5 TI 硬件
	5.1 开环 EVM
	5.2 应用 EVM
	5.3 控制卡
	5.4 参考设计

	6 编程器和调试器
	6.1 USB 转 GPIO2 接口适配器
	6.2 JTAG 调试器

	7 软件
	7.1 UCD3138x 培训实验室
	7.2 UCD3138 应用开发固件套件 Kit
	7.3 自定义固件

	8 开发工具
	8.1 Code Composer Studio (CCS)
	8.2 Fusion Digital Power Studio
	8.3 UniFlash

	9 应用
	9.1 多串联功率级
	9.2 多并联功率级
	9.3 高性能和外部通信
	9.4 功率密度高

	10 支持资源
	10.1 文档
	10.2 TI E2E 支持论坛

	11 总结
	12 参考资料



